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BAB III 

METODE PENELITIAN 

A. Jenis dan Pendekatan Penelitian 

Jenis penelitian yang digunakan yaitu quasi experiment. Salah satu ciri khas 

kuasi eksperimen yaitu penentuan kelas yang dijadikan kelas eksperimen dan 

kelas kontrol tanpa melalui proses randomisasi. Peneliti memilih dua kelas 

sebagai sampel sesuai dengan desain kuasi eksperimen (Isnawan, 2020). Desain 

ini dipilih untuk menguji penerapan model pembelajaran PjBL berbasis TPACK 

pada materi kimia hijau. Penelitian ini menerapkan pendekatan kuantitatif dalam 

pelaksanaannya, yaitu penelitian yang mengandalkan data berupa angka 

sehingga dapat dianalisis secara statistik atau numerik. Penelitian kuantitatif 

mencakup berbagai bentuk seperti eksperimen, survei, analisis korelasi, dan 

regresi (Rangkuti, 2016). Pada penelitian ini, pendekatan kuantitatif digunakan 

untuk mengetahui sejauh mana pengaruh penerapan model  PjBL berbasis 

TPACK pada materi kimia hijau dalam upaya mengembangkan kemampuan 

berpikir kritis peserta didik.  

B. Desain Penelitian 

Desain penelitian yaitu jenis Pre-Test and Post-Test with Non-Equivalent 

Control-Group Design. Pada desain ini, terdapat dua kelas yang dijadikan 

sampel, yaitu kelas eksperimen dan kelas kontrol.  Kelas eksperimen 

memperoleh perlakuan berupa penerapan model Project Based Learning (PjBL) 

berbasis TPACK, sedangkan kelas kontrol menggunakan model Problem Based 

Learning (PBL) sebagai pembelajaran konvensional. Kedua kelas diberikan pre-
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test sebelum pembelajaran untuk melihat kondisi awal, kemudian post-test 

setelah pembelajaran (Isnawan, 2020), guna mengetahui perubahan 

keterampilan berpikir kritis peserta didik. 

Pemilihan desain ini didasarkan pada kondisi di sekolah, dimana penentuan 

kelas tidak dapat dilakukan secara acak. Dengan demikian, penelitian ini 

memungkinkan peneliti membandingkan hasil berpikir kritis antara kelas 

eksperimen dan kontrol. Penerapan model PBL pada kelas kontrol bertujuan 

untuk menyetarakan perlakuan dalam penelitian ini. Selain itu, penerapan PBL 

di kelas kontrol juga relevan dengan kebijakan sekolah yang telah 

mengimplementasikan Kurikulum Merdeka. Kurikulum ini mendorong 

penggunaan beragam metode pembelajaran yang berpusat pada peserta didik, 

termasuk PBL, sehingga penerapannya bukanlah hal baru bagi guru maupun 

peserta didik. Dengan demikian, penggunaan PBL pada kelas kontrol tidak 

hanya menjaga kesetaraan perlakuan, tetapi juga selaras dengan praktik 

pembelajaran yang sudah pernah diterapkan di sekolah.  

Pada penelitian ini, pembelajaran baik di kelas eksperimen maupun kontrol 

dilaksanakan langsung oleh peneliti. Hal ini dilakukan atas permintaan guru 

mata pelajaran agar pembelajaran sesuai dengan rancangan yang telah disusun 

dalam instrumen penelitian. Selain itu, keterlibatan peneliti sebagai pengajar 

juga bertujuan untuk menjaga konsistensi implementasi model pembelajaran di 

kedua kelas. Jika pembelajaran diberikan oleh guru yang berbeda, terdapat 

kemungkinan perbedaan gaya mengajar, strategi, maupun pendekatan yang 

dapat memengaruhi hasil penelitian. Dengan demikian, kehadiran peneliti 
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sebagai pengajar dapat meminimalisasi bias perlakuan dan memastikan validitas 

hasil penelitian. 

Model PjBL berbasis TPACK menekankan pembelajaran berbasis proyek 

dengan dukungan teknologi, sedangkan PBL berfokus pada pemecahan masalah 

melalui keterlibatan aktif peserta didik. Keduanya sama-sama diarahkan untuk 

melatih keterampilan berpikir kritis (Hidayati & Wulandari, 2024). Meskipun 

kelas kontrol tidak menggunakan integrasi teknologi secara dominan, aspek 

Pedagogical Content Knowledge (PCK) tetap hadir, karena guru tidak hanya 

memahami materi (content) tetapi juga memiliki keterampilan pedagogis dalam 

menyampaikan materi sesuai dengan karakteristik peserta didik. (Sutamrin dkk., 

2022). Dalam konteks ini, teknologi pada PBL hanya berfungsi sebagai 

penunjang, sedangkan keterampilan pedagogis dan penguasaan materi menjadi 

aspek kunci dalam menciptakan pembelajaran yang efektif. Desain penelitian 

dapat dilihat pada Tabel 3.1 berikut. 

 Tabel 3. 1 Desain Penelitian 

Kelompok Tes Awal Perlakuan Tes Akhir 

Eksperimen Y1 X1 Y2 

Kontrol Y1 X2 Y2 

 

Keterangan: 

Y1: Tes awal (pre-test) yang diberikan kepada kedua kelompok (eksperimen 

dan kontrol) sebelum proses pembelajaran dimulai 

X1: Perlakuan model Project Based Learning (PjBL) berbasis TPACK 
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X2: Perlakuan model Problem Based Learning (PBL) 

Y2: Tes akhir (posttest) yang diberikan kepada kedua kelompok (eksperimen 

dan kontrol) setelah proses pembelajaran selesai. 

C. Setting Penelitian 

Penelitian ini dilakukan di SMA Negeri 1 Bati-Bati, yang beralamat di Jl. 

A. Yani Km. 33,3, Desa Nusa Indah, Kecamatan Bati-Bati, Kabupaten Tanah 

Laut, Kalimantan Selatan. Sekolah ini memiliki visi “Terwujudnya SMA Negeri 

1 Bati-Bati yang BUNGAS (Berkarakter, Unggul, Asri), yakni lulusan yang 

berkarakter dan unggul dalam penguasaan ilmu, teknologi, dan seni di era 

globalisasi dalam lingkungan belajar yang asri.” Penelitian dilaksanakan pada 

kelas X B dan X C dari tanggal 1 Agustus 2025 hingga 1 Oktober 2025, dengan 

jadwal kegiatan penelitian setiap hari Rabu dan Kamis. Berikut Tabel 3.2 

menyajikan jadwal kegiatan penelitian serta informasi kegiatan selama 

penelitian berlangsung. 

Tabel 3.2 Jadwal Kegiatan Penelitian 

Kelas Hari Jam Kegiatan Keterangan 

XB 

 

 

Selasa 08.00-

09.00 

Pre-test Dilaksanakan 

sebelum pertemuan 

pertama 

 

Kamis 07.45-

10.00 

Pertemuan 1: 

LKPD 1 

Pengenalan proyek, 

pembagian 

kelompok, dan 

penentuan topik 

proyek 

Antara 

Pertemuan 1–

2 

- Pengerjaan 

proyek 

Peserta didik 

mengerjakan proyek 

secara mandiri 

maupun kelompok di 

luar kelas dengan 
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pemantauan melalui 

aplikasi Trello 

Kamis 07.45-

10.00 

Pertemuan 2: 

LKPD 2 

Diskusi 

perkembangan 

proyek dan 

konsultasi hasil 

sementara 

Antara 

Pertemuan 2–

3 

- Lanjutan 

pengerjaan 

proyek 

Proyek dilanjutkan 

secara mandiri 

dengan pemantauan 

melalui aplikasi 

Trello 

Kamis 07.45–

10.00 

Pertemuan 3: 

LKPD 3 dan 

Post-test 

Presentasi hasil 

proyek dan evaluasi 

pembelajaran 

XC 

Selasa 09.00-

10.00 

Pre-test Dilaksanakan 

sebelum pertemuan 

pertama 

Rabu 12.00–

14.40 

Pertemuan 1: 

LKPD 1 

Orientasi masalah 

dan diskusi awal 

 

 

Rabu 12.00–

14.40 

Pertemuan 2: 

LKPD 2 

Analisis lanjutan 

pemecahan masalah 

Rabu 12.00–

14.40 

Pertemuan 3: 

LKPD 3 dan 

Post-test 

Presentasi dan 

evaluasi 

pembelajaran 

 

D. Populasi dan Sampel  

1. Populasi 

Populasi merupakan seluruh individu atau objek yang menjadi fokus dalam 

suatu penelitian, sedangkan sampel adalah sebagian dari populasi yang diambil 

dan digunakan untuk merepresentasikan ciri-ciri populasi tersebut 

(Subhaktiyasa, 2024). Populasi penelitian ini adalah seluruh peserta didik kelas 

X SMAN 1 Bati-Bati ajaran 2025/2026 yang terdiri dari 8 kelas yaitu  X A 

sampai X H dengan jumlah peserta didik sebanyak 288 orang.  
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2. Sampel 

Sampel penelitian ini ditentukan dengan menggunakan teknik purposive 

sampling. Menurut Sugiyono (2015, dalam Risnita & Jailani, 2023), 

“Pengambilan sampel sumber data dengan pertimbangan tertentu. Pertimbangan 

tertentu ini, misalnya orang tersebut yang dianggap paling tahu tentang apa yang 

kita harapkan, atau mungkin dia sebagai penguasa sehingga akan memudahkan 

peneliti menjelajahi objek atau situasi sosial yang diteliti” (Suriani dkk., 2023). 

Teknik purposive sampling dipilih karena peneliti tidak melakukan randomisasi, 

melainkan berdasarkan rekomendasi guru mata pelajaran kimia selaku 

pengampu. Pertimbangan tersebut dilakukan agar kelas yang dijadikan sampel 

sesuai dengan kebutuhan penelitian dan kondisi riil pembelajaran. 

Sejumlah kelas X yang ada di SMA Negeri 1 Bati-Bati, guru mata pelajaran 

kimia merekomendasikan dua kelas, yakni X B dan X C, untuk dijadikan sampel 

penelitian. Sebelum penetapan peran masing-masing kelas, dilakukan pre-test 

guna memperoleh gambaran kemampuan awal berpikir kritis peserta didik. Hasil 

analisis pre-test menunjukkan bahwa data kedua kelas berdistribusi normal, 

homogen, dan tidak terdapat perbedaan signifikan rata-rata kemampuan awal 

(Sig. 2-tailed = 0,970 > 0,05). Hal ini berarti kelas X B dan X C berada pada 

kondisi awal yang relatif seimbang.  

Meskipun demikian, hasil deskriptif menunjukkan bahwa rata-rata nilai 

kelas X C sedikit lebih tinggi dibandingkan kelas X B. Berdasarkan 

pertimbangan tersebut, kelas X C ditetapkan sebagai kelas kontrol yang 
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memperoleh pembelajaran dengan model konvensional yaitu Problem Based 

Learning (PBL), sedangkan kelas X B ditetapkan sebagai kelas eksperimen yang 

memperoleh pembelajaran dengan model Project Based Learning (PjBL) 

berbasis TPACK. Adapun jumlah peserta didik pada kelas X B sebanyak 34 

orang, sedangkan kelas X C juga berjumlah 34 orang. Penetapan ini sejalan 

dengan prinsip purposive sampling, karena pemilihan kelas dilakukan atas dasar 

pertimbangan relevansi, kesesuaian dengan tujuan penelitian, serta rekomendasi 

guru, meskipun tanpa melibatkan proses randomisasi (Lenaini, 2021).  

E. Data dan Sumber Data 

1. Data primer dalam penelitian ini diperoleh melalui hasil tes pengetahuan 

peserta didik, yaitu pre-test dan post-test yang dilaksanakan pada kelas 

eksperimen dan kelas kontrol.  

2. Data sekunder dalam penelitian ini mencakup informasi pendukung 

yang sudah tersedia sebelumnya, antara lain jumlah peserta didik kelas 

X di SMA Negeri 1 Bati-Bati, daftar nama peserta didik, serta hasil 

observasi keterlaksanaan model pembelajaran PjBL berbasis TPACK 

pada kelas eksperimen dan model PBL pada kelas kontrol.  

3. Sumber Data 

a. Literatur, meliputi berbagai referensi yang relevan dengan 

penelitian, seperti buku, jurnal, maupun hasil penelitian 

terdahulu yang berkaitan dengan model PjBL, TPACK, 

keterampilan berpikir kritis, dan materi kimia hijau. 
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b. Informan, yaitu pihak-pihak yang memberikan informasi 

pendukung, seperti kepala sekolah, staf pendidik, dan guru kimia 

kelas X di SMA Negeri 1 Bati-Bati. 

c. Responden, yakni peserta didik kelas X SMA Negeri 1 Bati-Bati 

yang dipilih sebagai sampel penelitian. 

d. Dokumen, berupa arsip atau catatan resmi yang mendukung 

penelitian, misalnya daftar nama peserta didik, data jumlah 

siswa, serta dokumen atau gambar lain yang relevan. 

e. Observer, yaitu guru mata pelajaran dan teman sejawat yang 

telah menyelesaikan studi, yang berperan membantu dalam 

melakukan observasi keterlaksanaan pembelajaran.  

Matriks data dan sumber data dalam penelitian ini dapat dilihat pada Tabel 

3.3 berikut. 

Tabel 3. 3 Matriks Data dan Sumber Data Penelitian 

Data Penelitian Sumber Data Penelitian 

Data Primer Hasil pre-test dan 

post-test 

pengetahuan peserta 

didik  

Responden 

 

Peserta didik di Kelas XB 

dan XC SMAN 1 Bati-Bati 

mata pelajaran kimia 

 

Informasi 

pelaksanaan 

pembelajaran 

Informan 

 

Guru mata pelajaran kimia 

kelas X SMA Negeri 1 

Bati-Bati 

Data 

Sekunder 

Jumlah peserta didik, 

jadwal pelajaran, dan 

daftar nama kelas X 

B dan X C  

Dokumen Semua catatan atau arsip 

tertulis memuat data 

informasi yang mendukung 

penelitian 
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Data Penelitian Sumber Data Penelitian 

Hasil observasi 

keterlaksanaan 

pembelajaran PjBL 

berbasis TPACK 

(kelas eksperimen) 

dan PBL (kelas 

kontrol) 

Observer Teman sejawat yang telah 

lulus kuliah 

 

F. Teknik Pengumpulan Data 

1. Tes 

Tes digunakan sebagai instrumen pengumpulan data terkait kemampuan 

peserta didik dalam menyelesaikan soal setelah penerapan model pembelajaran. 

Instrumen tes yang disusun berjumlah 20 butir soal esai, terdiri atas 10 soal untuk 

pre-test dan 10 soal untuk post-test. Dari jumlah tersebut, peneliti mengambil 5 

soal pada masing-masing tes yang disusun berdasarkan indikator keterampilan 

berpikir kritis menurut Robert Hugh Ennis. 

Pelaksanaan tes dilakukan dua kali, yaitu sebelum dan sesudah 

pembelajaran. Pada tahap pre-test, kedua kelas (eksperimen dan kontrol) 

mengerjakan soal dalam bentuk cetak (paper based) karena pada tahap tersebut 

belum ditentukan kelas eksperimen maupun kelas kontrol. Sementara itu, pada 

tahap post-test terdapat perbedaan mekanisme: kelas kontrol tetap menggunakan 

media cetak, sedangkan kelas eksperimen mengerjakan soal melalui Google 

Form sebagai bentuk integrasi teknologi digital dalam pembelajaran berbasis 

TPACK. 
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Durasi waktu pengerjaan tes pada kedua kelas ditetapkan selama 60 menit. 

Tes ini bertujuan untuk mengukur keterampilan berpikir kritis peserta didik pada 

materi kimia hijau serta menjadi dasar bagi peneliti dalam menganalisis 

perubahan keterampilan berpikir kritis sebelum dan setelah pembelajaran 

berlangsung 

2. Angket 

Angket yang digunakan dalam penelitian ini merupakan angket respon 

peserta didik yang disusun untuk mengetahui tanggapan mereka terhadap 

pelaksanaan pembelajaran sebagai bahan pendukung dari instrumen. Angket 

tersebut berisi 15 pernyataan yang diberikan baik kepada kelas eksperimen 

maupun kelas kontrol. Pada kelas eksperimen, angket digunakan untuk 

mengukur respon peserta didik terhadap penerapan model pembelajaran berbasis 

proyek (Project Based Learning) yang terintegrasi dengan kerangka 

Technological Pedagogical Content Knowledge (TPACK), sedangkan pada 

kelas kontrol digunakan untuk menilai respon peserta didik terhadap model 

Problem Based Learning (PBL). Penelitian ini menggunakan observasi untuk 

mengevaluasi implementasi model pembelajaran. Observasi dilakukan melalui 

lembar observasi keterlaksanaan model pembelajaran yang diisi oleh observer 

dengan mengamati peneliti selama proses pembelajaran berlangsung, baik di 

kelas eksperimen maupun kelas kontrol. Lembaran yang digunakan dalam 

penelitian ini adalah lembar observasi dibuat dalam bentuk checklist 

menggunakan skala Guttman dengan jawaban dilakukan atau tidak dilakukan.  
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3. Dokumentasi  

Dokumentasi dalam penelitian ini dilakukan dengan merekam berbagai 

kegiatan selama proses pembelajaran dalam bentuk foto maupun video. 

Dokumentasi dilaksanakan langsung oleh peneliti di lokasi penelitian, yaitu 

SMAN 1 Bati-Bati. Tujuan dari dokumentasi ini adalah sebagai data pendukung 

yang bersifat visual, sekaligus sebagai bahan pelengkap untuk memperkuat hasil 

penelitian terkait pelaksanaan pembelajaran.  

G. Instrumen Penelitian 

Instrumen penelitian berfungsi memperoleh data yang relevan sehingga 

mendukung analisis hasil penelitian. Pada penelitian ini, instrumen yang 

digunakan meliputi tes berupa pre-test dan post-test, lembar observasi 

keterlaksanaan pembelajaran, serta modul ajar Kurikulum Merdeka yang 

mencakup Alur Tujuan Pembelajaran (ATP) dan rangkaian kegiatan 

pembelajaran, serta Lembar Kerja Peserta Didik (LKPD). 

Tes yang digunakan berbentuk soal esai yang dikembangkan berdasarkan 

indikator keterampilan berpikir kritis menurut Robert Hugh Ennis. Total soal 

yang disusun berjumlah 20 butir, terdiri atas 10 soal untuk pre-test dan 10 soal 

untuk post-test. Lima soal dari masing-masing tes dipilih untuk dianalisis dalam 

penelitian. Instrumen tes ini mengukur keterampilan berpikir kritis peserta didik 

pada materi kimia hijau baik di kelas eksperimen maupun kelas kontrol. 

Pemberian pre-test dan post-test memungkinkan peneliti mengevaluasi 

perubahan kemampuan berpikir kritis sebelum dan sesudah perlakuan. 
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Lembar observasi keterlaksanaan digunakan sebagai instrumen pendukung 

yang berfungsi mencatat sejauh mana implementasi model pembelajaran sesuai 

perencanaan. Observasi ini memastikan setiap tahapan pembelajaran 

berlangsung secara sistematis dan mengikuti prosedur yang telah ditetapkan. 

Modul ajar Kurikulum Merdeka dirancang secara komprehensif dengan 

mencakup ATP, rangkaian kegiatan pembelajaran, dan LKPD sebagai bahan ajar 

peserta didik. Keberadaan modul ajar mendukung efektivitas pembelajaran 

sekaligus memberikan pengalaman belajar yang lebih terstruktur sesuai dengan 

konsep Kurikulum Merdeka. 

Keabsahan instrumen penelitian dijamin melalui validasi oleh dosen ahli 

serta guru kimia berpengalaman. Instrumen yang telah divalidasi kemudian diuji 

coba kepada peserta didik yang telah mempelajari materi relevan. Uji coba 

tersebut memastikan bahwa instrumen penelitian memiliki validitas dan 

reliabilitas yang memadai sehingga layak digunakan untuk mengukur 

keterampilan berpikir kritis di kelas eksperimen maupun kelas kontrol. 

 

H. Teknik Analisis Data 

Penelitian ini menggunakan pendekatan kuantitatif dalam analisis data. Data 

yang diperoleh dari hasil pre-test dan post-test dianalisis dengan bantuan 

software SPSS versi 26. Analisis dilakukan melalui beberapa tahapan, yaitu uji 

normalitas, uji homogenitas, dan uji hipotesis.  
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1. Uji Statistik Deskriptif 

Statistik deskriptif pada hakikatnya adalah proses merangkum dan 

menyajikan data penelitian ke dalam bentuk yang lebih sederhana sehingga 

mudah dipahami serta dianalisis. Melalui tabulasi, data dapat diringkas, diatur, 

dan ditampilkan baik dalam bentuk angka maupun grafik. Umumnya, teknik ini 

dimanfaatkan peneliti untuk menggambarkan karakteristik variabel yang diteliti 

sekaligus mendukung interpretasi hasil penelitian. Aktivitas dalam statistik 

deskriptif meliputi perhitungan nilai rata-rata (mean), median, modus, standar 

deviasi (Trimono dkk., 2023). 

2. Analisis Data Pre-Test 

a. Uji Normalitas 

Uji normalitas dilakukan untuk mengetahui apakah data pre-test 

berdistribusi normal atau tidak. Metode yang digunakan adalah Kolmogorov-

Smirnov dan Shapiro-Wilk. Data dinyatakan berdistribusi normal apabila nilai 

signifikansi (sig.) lebih besar atau sama dengan 0,05, sedangkan nilai 

signifikansi kurang dari 0,05 menunjukkan data tidak normal (Isnawan, 2020).  

Langkah-langkah dalam melakukan uji normalitas dengan SPSS versi 

26 adalah sebagai berikut: Masukkan data ke Data View, kemudian pilih 

Analyze → Descriptive Statistics → Explore. Selanjutnya, masukkan data ke 

dalam Dependent List, klik Button Plots, lalu tekan Continue, dan akhiri dengan 

mengklik OK. 
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b. Uji Homogenitas 

Uji homogenitas bertujuan untuk mengetahui apakah varians dari dua 

kelompok data pre-test bersifat homogen. Data dikatakan homogen apabila nilai 

signifikansi lebih dari 0,05 (Sianturi, 2022). Adapun langkah-langkah uji 

homogenitas menggunakan SPSS yaitu, masukkan data dengan memilih View 

→ Value → Add → Input, lalu klik Analyze → Compare Means → One-Way 

ANOVA. Selanjutnya, masukkan data ke dalam Dependent List, tentukan 

Factor, kemudian pilih Options dan centang Homogeneity of Variance Test. 

Terakhir, tekan Continue, lalu OK untuk menjalankan uji. 

c. Uji Beda (Uji Perbedaan Kemampuan Awal)  

Tahap berikutnya adalah menguji perbedaan kemampuan awal antara 

kelas eksperimen dan kontrol. Jika data normal dan homogen, maka digunakan 

Independent Sample T-Test. Namun apabila salah satu syarat tidak terpenuhi, 

maka digunakan uji nonparametrik Mann-Whitney. 

3. Analisis Data Post-Test 

a. Uji Normalitas 

Sama seperti pada pre-test, uji normalitas pada data post-test bertujuan 

memastikan distribusi data setelah perlakuan. Data dikatakan normal jika nilai 

signifikansi ≥ 0,05.  

b. Uji Homogenitas 

Uji homogenitas pada post-test dilakukan untuk menilai kesamaan 

varians antar kelompok setelah diberikan perlakuan. Kriteria yang digunakan 

adalah jika sig. > 0,05, maka data bersifat homogen (Sianturi, 2022). 
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c. Uji Hipotesis (Uji Pengaruh Perlakuan) 

Tahap terakhir adalah pengujian hipotesis untuk melihat efektivitas 

perlakuan. Apabila data normal dan homogen, digunakan Independent Sample 

T-Test, sedangkan jika tidak memenuhi kriteria tersebut digunakan uji Mann-

Whitney U. (Amruddin dkk., 2022). Adapun langkah-langkah uji hipotesis 

dengan Independent Sample T-Test pada SPSS yaitu, input data melalui Variable 

View → Values → Data View, pilih Analyze → Compare Means → 

Independent Sample T Test, masukkan data ke dalam Test Variable, klik Define 

Group → Isi Grouping Variables → OK. 

Dasar pengambilan keputusan yaitu jika nilai sig. (2-tailed) < 0,05, 

maka H₀ ditolak dan Ha diterima, artinya terdapat perbedaan signifikan antara 

kelas eksperimen dan kelas kontrol. Jika nilai sig. (2-tailed) ≥ 0,05, maka H₀ 

diterima dan Ha ditolak, artinya tidak terdapat perbedaan signifikan antara kedua 

kelompok.  

Melalui tahapan analisis tersebut dapat diketahui efektivitas penerapan 

model Project Based Learning (PjBL) berbasis TPACK pada kelas eksperimen 

dibandingkan dengan model Problem Based Learning (PBL) pada kelas kontrol 

dalam meningkatkan keterampilan berpikir kritis peserta didik. 

4. Persentase Ketuntasan 

Analisis kuantitatif dalam penelitian ini diperoleh dari hasil tes berpikir 

kritis yang dilakukan melalui perhitungan persentase rata-rata ketuntasan 

belajar. Dalam penelitian ini, data dianalisis secara kuantitatif dengan meninjau 
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tingkat ketuntasan belajar secara klasikal. Ketuntasan belajar klasikal dapat 

dihitung dengan menggunakan rumus persentase, yaitu. 

KBK =  
Jumlah peserta didik yang mencapai ketuntasan

Jumlah seluruh peserta didik 
 × 100% 

Rumus tersebut digunakan untuk mengetahui persentase peserta didik 

dalam satu kelas yang telah memenuhi kriteria ketuntasan minimal (Zuhannisa’ 

dkk., 2023). Tingkat keterampilan berpikir kritis peserta didik juga dianalisis 

berdasarkan pencapaian tiap indikator. Instrumen yang digunakan berupa soal 

esai yang disusun untuk merepresentasikan indikator-indikator keterampilan 

berpikir kritis. Setiap butir soal memiliki bobot skor yang berbeda, yaitu soal 

nomor 1 bernilai 15, soal nomor 2 bernilai 15, soal nomor 3 bernilai 25, soal 

nomor 4 bernilai 15, dan soal nomor 5 bernilai 30. Data hasil tes tersebut 

kemudian diolah untuk mengetahui persentase capaian masing-masing indikator. 

Persentase indikator dihitung dengan menggunakan rumus: 

P =
Jumlah skor yang diperoleh

Jumlah skor maksimal
 × 100% 

Rumus persentase di atas berfungsi untuk menilai tingkat ketuntasan 

hasil tes kemampuan berpikir kritis peserta didik (Kurniasari dkk., 2023), pada 

pembelajaran kimia materi kimia hijau. Hasil persentase yang diperoleh 

selanjutnya dikelompokkan ke dalam beberapa kategori tingkat kemampuan 

berpikir kritis. Tabel 3.4 berikut menunjukkan kriteria persentase skor 

keterampilan berpikir kritis siswa yang digunakan sebagai acuan dalam 

penelitian ini (Wike Aprilia Ningrum, 2023; berdasarkan Agip, Z dalam Silaban 

et al., 2022).  



53 

 

 

 
 

Tabel 3. 4 Klasifikasi Tingkat Kemampuan Berpikir Kritis Peserta Didik 

Presentase Kategori 

86-100 Sangat Tinggi 

71-85 Tinggi 

56-70 Sedang 

41-55 Rendah 

<40 Sangat Rendah 

  (Ningrum dkk., 2023) 

 

5. Analisis N-Gain 

Analisis Normalized Gain (N-Gain) digunakan untuk mengetahui 

sejauh mana peningkatan keterampilan berpikir kritis peserta didik setelah 

diterapkannya suatu model pembelajaran. Perhitungan N-Gain  dilakukan 

dengan membandingkan hasil pre-test dan post-test peserta didik. Rumus yang 

digunakan adalah sebagai berikut: 

N − Gain =
𝑆𝑘𝑜𝑟 𝑃𝑜𝑠𝑡 − 𝑡𝑒𝑠𝑡 − 𝑠𝑘𝑜𝑟 𝑝𝑟𝑒 − 𝑡𝑒𝑠𝑡 

𝑆𝑘𝑜𝑟 𝑖𝑑𝑒𝑎𝑙 − 𝑠𝑘𝑜𝑟 𝑝𝑟𝑒 − 𝑡𝑒𝑠𝑡
 

Hasil perhitungan N-Gain kemudian diinterpretasikan, kategori 

interpretasi N-Gain score mengacu pada Hake (1999) dalam Sundayana (2015), 

yang juga digunakan oleh Marfiatul Hajjah (2022) dalam penelitiannya yang 

disajikan pada Tabel 3.5 berikut. 

Tabel 3. 5 Interpretasi N-Gain Score 

Faktor g Kategori 

-1,00 < g < 0,00 Terjadi penurunan 

g = 0,00 Tetap 

0,00 < g < 0,30 Rendah 

0,30 < g < 0,70 Sedang 



54 

 

 

 
 

Faktor g Kategori 

0,70 < g < 1,00 Tinggi 

    (Hajjah dkk., 2022) 

Setelah diperoleh nilai N-Gain, langkah selanjutnya adalah melakukan 

analisis statistik inferensial untuk memastikan validitas hasil penelitian. Analisis 

ini meliputi uji normalitas, uji homogenitas, dan uji perbedaan rata-rata N-Gain. 

Uji normalitas digunakan untuk mengetahui apakah data N-Gain berdistribusi 

normal, salah satunya dengan uji Shapiro–Wilk pada taraf signifikansi 0,05. 

Selanjutnya, dilakukan uji homogenitas varians untuk melihat kesamaan varians 

antar kelompok. Jika data berdistribusi normal, maka uji perbedaan rata-rata 

dapat dilakukan dengan independent sample t-test. Namun, apabila data tidak 

normal, maka digunakan uji nonparametrik yaitu Mann–Whitney U Test sebagai 

alternatif (Padmiati dkk., 2024). 

Penelitian ini melalui beberapa tahapan analisis data. Pertama, statistik 

deskriptif digunakan untuk menyajikan data penelitian dalam bentuk yang lebih 

sederhana dan mudah dipahami. Kedua, uji normalitas dilakukan untuk 

memastikan distribusi data. Ketiga, uji homogenitas digunakan untuk melihat 

kesamaan varians antar kelompok. Selanjutnya, uji hipotesis dilakukan melalui 

uji beda (Independent Sample T-Test atau Mann-Whitney U Test) untuk 

mengetahui perbedaan keterampilan berpikir kritis antara kelas eksperimen dan 

kelas kontrol. Analisis dilengkapi dengan perhitungan persentase ketuntasan 

belajar peserta didik secara klasikal serta analisis N-Gain untuk menilai 

peningkatan keterampilan berpikir kritis sebelum dan sesudah perlakuan. 
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I. Teknik Validitas dan Keabsahan Data 

Teknik validitas dan keabsahan data dilakukan sebelum penelitian untuk 

mengolah data. Uji validitas dan reliabilitas digunakan untuk memastikan 

instrumen penelitian valid dan reliabel (Isnawan, 2020). 

1. Uji Validitas 

Penelitian ini menerapkan uji validitas sebagai bagian dari analisis 

instrumen. Istilah validitas berasal dari kata validity, yang mengandung makna 

ketepatan serta kebenaran suatu instrumen dalam mengukur apa yang 

seharusnya diukur, validitas menunjukkan tingkat kemampuan suatu instrumen 

mampu menjalankan fungsi pengukurannya dengan tepat. Menurut Sugiyono 

(2005) dalam Sugiono (2020), validitas merupakan indeks yang menegaskan 

bahwa suatu alat ukur dapat digunakan secara akurat untuk mengukur objek yang 

semestinya diukur (Sugiono dkk., 2020). Pada penelitian ini, uji validitas 

dilakukan melalui proses validasi oleh validator serta pengujian terhadap butir 

soal.  

a. Uji Validitas kepada Tim Validator  

Sebelum instrumen penelitian diberikan kepada peserta didik, 

terlebih dahulu dilakukan proses validasi untuk memastikan kualitas dan 

kelayakan instrumen yang digunakan. Pada penelitian ini, proses validasi 

dilakukan oleh tiga validator yang terdiri atas dua dosen, yaitu Ibu Trining Puji 

Astutik, S.Si., S.Pd., M.Pd. serta Ibu Helda Rahmawati, S.Si., M.Pd. yang 

merupakan dosen pada Program Studi Tadris Kimia, Fakultas Tarbiyah dan 

Keguruan, UIN Antasari Banjarmasin. Selain itu, seorang pendidik dari SMAN 
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1 Bati-Bati, yaitu Ibu Nurmila, ST., juga dilibatkan sebagai validator. Hasil 

penilaian validitas instrumen oleh para validator dan kriteria validitas  menurut 

Akbar dalam Saputri (2023) disajikan pada Tabel 3.6 berikut. 

 Tabel 3. 6 Kriteria validasi 

 

 

    (Saputri dkk., 2023) 

Rekapitulasi persentase hasil validasi instrumen penelitian bisa dilihat 

pada Tabel 3.7 berikut. 

 Tabel 3.7 Rekapitulasi Persentase Hasil Validasi Instrumen Penelitian  

No. Nama Instrumen Hasil 

Validasi (%) 

Kriteria 

Validitas 

1 Modul Ajar Kelas Eksprimen 92 Sangat Valid 

2 Modul Ajar Kelas Kontrol 91 Sangat Valid 

3 Materi 78 Cukup Valid 

4 Elektronik- Lembar Kerja 

Peserta Didik (E- LKPD) 

Kelas Eksperimen 

 

93 Sangat Valid 

5 Lembar Kerja Peserta Didik 

(LKPD) Kelas Kontrol 

 

90 Sangat Valid 

6 Instrumen Pre-Test  

 

87 Sangat Valid 

7 Instrumen Post-Test 88 Sangat Valid 

8 Lembar Observasi 

Keterlaksanaan Model 

Pembelajaran Kelas 

Eksperimen 

90 Sangat Valid 

9 Lembar Observasi 

Keterlaksanaan Model 

Pembelajaran Kelas Kontrol 

 

90 Sangat Valid 

10 Angket Respon Peserta Didik 

Kelas Eksperimen 

 

90 Sangat Valid 

No Skor Kriteria Validitas 

1 85,1% - 100% Sangat Valid 

2 70,1% - 85% Cukup Valid 

3 50,1% - 70% Kurang Valid 

4 0% - 50% Tidak Valid 
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No. Nama Instrumen Hasil 

Validasi (%) 

Kriteria 

Validitas 

11 Angket Respon Peserta Didik 

Kelas Kontrol 

 

90 Sangat Valid 

 

b. Uji Validitas Soal 

Pelaksanaan uji validitas dimaksudkan untuk mengetahui sejauh 

mana butir soal mampu merepresentasikan konstruk yang hendak diukur dalam 

penelitian ini. Suatu instrumen dinyatakan valid apabila nilai r-hitung yang 

diperoleh lebih besar daripada r-tabel, sedangkan apabila nilai r-hitung lebih 

kecil dari r-tabel, maka butir soal dinyatakan tidak valid. Proses analisis validitas 

dilakukan dengan bantuan program SPSS versi 26 for Windows melalui tahapan: 

Data → Analyze → Correlate → Bivariate → memasukkan variabel → 

memilih Pearson Correlation → OK. 

Nilai korelasi (r-hitung) selanjutnya dibandingkan dengan nilai r-

tabel pada taraf signifikansi 5%. Jika diperoleh r-hitung < r-tabel, maka butir 

soal tidak signifikan sehingga dinyatakan tidak valid. Sebaliknya, apabila r-

hitung > r-tabel, maka korelasi signifikan dan instrumen soal tersebut dapat 

dinyatakan valid. Uji coba instrumen dilaksanakan dengan memanfaatkan 

Google Form untuk mengumpulkan data dari peserta didik kelas XI A SMAN 1 

Bati-Bati. Responden yang dipilih adalah peserta didik yang telah memperoleh 

materi Kimia Hijau sebelumnya. Rekapitulasi hasil pengujian validitas tiap butir 

soal disajikan dalam Tabel 3.8 berikut. 
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Tabel 3. 8 Kesimpulan Hasil Validitas Uji Coba Pre-Test 

Nomor 

Soal 

r-hitung (Pearson 

Correlation) 

r-tabel  Kesimpulan 

1 0,850 

0,468 

Valid 

2 0,823 Valid 

3 -0,037 Tidak Valid 

4 0,754 Valid 

5 0,641 Valid 

6 0,530 Valid 

7 0,881 Valid 

8 -0,315 Tidak Valid 

9 0,821 Valid 

10 0,726 Valid 

 

Berdasarkan hasil perhitungan uji validitas menggunakan korelasi 

Pearson Product Moment melalui program SPSS versi 26 for Windows, 

diperoleh nilai korelasi antara setiap butir soal dengan skor total. Dengan jumlah 

responden sebanyak 18 orang, maka diperoleh r-tabel pada taraf signifikansi 5% 

0,468. Hasil analisis menunjukkan bahwa dari 10 butir soal yang diuji, terdapat 

8 soal yang memiliki nilai r-hitung > 0,468 sehingga dinyatakan valid (nomor 1, 

2, 4, 5, 6, 7, 9, dan 10). Sementara itu, terdapat 2 soal yang memiliki nilai r-

hitung < 0,468 sehingga dinyatakan tidak valid (nomor 3 dan 8). Kesimpulan 

hasil validitas uji coba pada post-test disajikan pada Tabel 3.9 berikut. 

    Tabel 3. 9 Kesimpulan Hasil Validitas Uji Coba Post-Test 

Nomor 

Soal 

r-hitung (Pearson 

Correlation) 

r-tabel  Kesimpulan 

1 0,721 

0,468 

Valid 

2 0,789 

 

Valid 

3 -0,163 

 

Tidak Valid 

4 0,735 

 

Valid 

5 0,735 

 

Valid 

6 0,168 Tidak Valid 
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Nomor 

Soal 

r-hitung (Pearson 

Correlation) 

r-tabel  Kesimpulan 

 

7 0,540 

 

Valid 

8 0,383 

 

Tidak Valid 

9 0,722 

 

Valid 

10 0,879 

 

Valid 

 

Berdasarkan hasil perhitungan uji validitas di atas hasil analisis 

menunjukkan bahwa dari 10 butir soal post-test yang diuji, terdapat 7 soal yang 

memiliki nilai r-hitung > 0,468 sehingga dinyatakan valid (nomor 1, 2, 4, 5, 7, 

9, dan 10). Sementara itu, terdapat 3 soal yang memiliki nilai r-hitung < 0,468 

sehingga dinyatakan tidak valid (nomor 3, 6, dan 8). 

Berdasarkan hasil uji validitas, dari 10 butir soal yang dikembangkan 

hanya 8 butir yang dinyatakan valid pada pre-test dan 7 butir pada post-test. 

Untuk menjaga konsistensi instrumen antara pre-test dan post-test, peneliti 

hanya menggunakan butir soal yang valid pada kedua tes. Dengan demikian, soal 

nomor 3, 6, dan 8 tidak digunakan lebih lanjut karena tidak memenuhi kriteria 

validitas. Selain itu, butir nomor 9 dan 10 juga tidak dipakai meskipun valid, 

sebab peneliti juga mempertimbangkan keterwakilan indikator agar setiap aspek 

keterampilan berpikir kritis dapat terukur secara proporsional dan indikator soal 

yang ada pada nomor 9 dan 10 telah tercakup pada soal lain. Dengan demikian, 

diperoleh lima butir soal yang digunakan dalam penelitian, berikut Tabel 3.10 

pemetaan butir soal. 
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Tabel 3. 10 Pemetaan Butir Soal Berdasarkan Materi dan Indikator  

Keterampilan Berpikir Kritis  

Nomor 

Soal 

Materi Indikator Keterampilan Berpikir 

Kritis 

1 Konsep & Definisi 

Kimia Hijau 

Memberikan penjelasan sederhana 

2 Manfaat Kimia Hijau Mengembangkan keterampilan 

dasar 

4 12 Prinsip Kimia 

Hijau 

Menarik kesimpulan 

5 12 Prinsip Kimia 

Hijau 

Mendefinisikan istilah penting 

7 
Aplikasi Kimia 

Hijau 

Merencanakan strategi dan taktik 

 

 

Tabel di atas menunjukkan pemetaan butir soal yang digunakan 

dalam penelitian. Pemilihan soal didasarkan pada hasil uji validitas serta 

pertimbangan keterwakilan indikator keterampilan berpikir kritis. Butir soal 

nomor 1 mengukur indikator memberikan penjelasan sederhana pada materi 

konsep dan definisi Kimia Hijau. Soal nomor 2 memfokuskan pada indikator 

mengembangkan keterampilan dasar melalui materi manfaat Kimia Hijau. 

Selanjutnya, soal nomor 4 mengukur kemampuan menarik kesimpulan terkait 12 

Prinsip Kimia Hijau, sedangkan soal nomor 5 berorientasi pada indikator 

mendefinisikan istilah penting dengan cakupan materi yang sama. Terakhir, soal 

nomor 7 mengukur indikator merencanakan strategi dan taktik pada materi 

aplikasi Kimia Hijau. Dengan komposisi ini, kelima butir soal telah mencakup 

indikator keterampilan berpikir kritis secara representatif sekaligus sesuai 

dengan cakupan materi penelitian.   
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2. Uji Reliabilitas 

Uji reliabilitas dilaksanakan setelah tahap validitas dengan tujuan 

memastikan bahwa instrumen yang digunakan dapat memberikan hasil yang 

konsisten dari waktu ke waktu (Utami, 2023). Teknik yang dipakai adalah 

analisis Cronbach’s Alpha, yang berfungsi menilai tingkat konsistensi internal 

antarbutir dalam suatu variabel. Apabila nilai Cronbach’s Alpha melebihi 0,60, 

maka instrumen dinyatakan reliabel atau memiliki tingkat konsistensi yang baik 

secara (S. K. Dewi & Sudaryanto, 2020).  

Uji reliabilitas instrumen dalam penelitian ini dilakukan menggunakan 

SPSS versi 26 for Windows dengan tahapan yaitu pertama, masukkan data, lalu 

pilih Analyze → Scale → Reliability Analyze. Selanjutnya, tambahkan item dan 

pilih model Alpha, kemudian buka menu Statistic dan centang opsi Item, Scale, 

Item-Scale Deleted, serta Inter-Item Correlations. Terakhir, klik Continue lalu 

OK untuk menjalankan analisis. Kategori interpretasi koefisien reliabilitas 

berdasarkan Guilford (1956) dalam Indrasari (2022) disajikan pada Tabel 3.11 

berikut.   

 Tabel 3. 11 Koefisien Reliabilitas 

Koefisien Reliabilitas (r11) Tingkat Reliabilitas 

0,80< r11 ≤ 1,00 Sangat Tinggi 

0,60 < 𝑟11 ≤ 0,80 Tinggi 

0,40 < 𝑟11 ≤ 0,60 Sedang 

0,20< 𝑟11 ≤ 0,40 Rendah 

-1,00< 𝑟11 ≤ 0,20 Sangat rendah 

   Sumber: (Indrasari dkk., 2022). 

Hasil analisis reliabilitas instrumen ditampilkan pada Tabel 3.12  dan 3.13 

yang memuat informasi mengenai reliabilitas soal pre-test dan post-test. 
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Tabel 3. 12 Hasil Uji Reliabilitas Soal Pre-Test  

 

Tabel 3. 13  Hasil Uji Reliabilitas Soal Post-Test 

 

 Berdasarkan hasil analisis, instrumen pre-test memperoleh nilai 

Cronbach’s Alpha sebesar 0,770 dengan jumlah 10 butir soal. Nilai ini berada 

pada rentang 0,60 < r11 ≤ 0,80 sehingga termasuk kategori tinggi, artinya 

instrumen pre-test dapat dikatakan reliabel. Sementara itu, instrumen post-test 

menghasilkan nilai Cronbach’s Alpha sebesar 0,691 dengan jumlah soal yang 

sama, yaitu 10 butir. Nilai tersebut juga berada di atas batas minimal 0,60 

sehingga tergolong reliabel meskipun konsistensinya tidak setinggi pre-test. 

Dengan demikian, baik instrumen pre-test maupun post-test dapat dinyatakan 

layak digunakan dalam penelitian ini karena keduanya memenuhi syarat 

reliabilitas meskipun terdapat perbedaan tingkat konsistensi antarbutir soal. 

 

 

 

 

 

Cronbach’s Alpha N of Items 

0,770 10 

Cronbach’s Alpha N of Items 

0,691 10 


